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gemiusExplorer — Introduction

1 Introduction

This user guide describes the possibilities and methods of using the application

gemiusExplorer =iz,

gemiusExplorer is a special analytical software that enables the analysis of web site

audience research results.

It is possible to use gemiusExplorer on computers working under Windows operating
system. There is no need to install the application — it is enough to execute the

application file.
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2 First steps

2.1

Opening the dataset

In order to analyze the web site audience, one has to use the option Open... in the File

menu of gemiusExplorer. The dataset can also be opened with the icon 0.

While opening the site audience files the authorization process is being conducted —
one has to enter login and password and then press the button Send. Data is being
send by the internet to the authorization server where it is verified. If the user is

approved to get access to particular dataset, the file is loaded.

x|

- = =

5= Gemius

The data presented is copyrighted and protected under appropriate international
copyright laws. Al rights reserved.

Aocess to these data can only be given to authonized users.

[t iz neceszany to connect to the authorization server bo vernify the
uzer's icenze.

Lagin: |E-:umpany:|‘~|ame.5urname

xxxxxxx)i EEI"I

Pazzward:

lllustration 1 Log-in window

Notice: during authorization of the license, the user’'s computer has to have possibility

of connecting with the internet.

2.2 Application view

After opening the site audience analysis, the data is being presented in three
navigation panels. On the left side there is a panel with media tree (1) and panel with

aggregates tree (2), whereas on the right side there is a panel with the table

presenting the research results (3).
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llustration 2 Application view with research results

The media tree panel presents nodes of internet web sites (icon @). The internet web
site can be presented as a whole or can be divided into different services (icon [J).
Some of the nodes can be of “chat” type (icon ='). The web sites are grouped into

collecting nodes according to the category (icon ).

The aggregates tree panel enables to load or define any alternative trees. The

aggregates nodes are marked with icon % Detailed information about defining the

aggregates trees are provided in chapter 6: ,,Aggregates tree” (page 25).

The panels can be moved and their position or size can be changed. It is also possible
to close media tree or aggregates tree panel — one only has to click on the closing
button ,x”. In order to switch on any of these two panels one has to use options Media

tree or Aggregates tree in the View menu.

2.3 Research results analysis

In order to check what is the audience of the web site we are interested in, one should
select that site in the left panel. After that in the right panel the table with basic
statistics is being presented: number of visitors (real users), number of page views,
average time spent on the site per visitor (real user), reach and audience composition

in the given target group

The nodes from the media tree and aggregates tree can be analyzed at the same time

— one just has to select particular nodes from each tree.
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lllustration 3 Presentation of data for nodes from media tree and aggregates tree

The operations carried out the most frequently are as follows:

- Selection of metrics presented (e.g. the display of data for the ,average page

view duration” metric) — see chapter 4.1: “Metrics selection” (page 10).

- Data sorting (e.g. decreasingly by the number of page views) — see chapter 4.2

»Data sorting” (page 11).

- Quick selection of nodes (e.g. selection of all web sites from the collecting node

— from ‘catalog’) — see chapter 4.4 ,Selection and deselection of groups of nodes”

(page 12).

- Target group definition (e.g. data analysis for the target group defined as ,,men”
or for the group defined as ,women with higher education”) — see chapter 5

"Target group definition” (page 18).

- Definition of age intervals in target group (e.g. definition of target group

~persons age 20-30") — see chapter ,,Defining age intervals” (page 21).

- Definition of aggregates tree — see chapter 6.1 ,Defining a new aggregates

tree” (page 25).

- Exporting data to Excel — see chapter 7.1 ,,Data export” (page 28).
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Saving an analysis (in order to e.g. be able to analyze the results next day and
have the right web sites selected in the application already, needed metrics
displayed, target groups defined etc.) — see chapter 7.2 ,Saving an analysis”

(page 28).
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3 Modes of analysis

The data are available in the following modes of analysis:

5| Reach ranking — data for nodes with the highest number of visitors (real
users), that is with the highest reach in a given target group, are presented.

For detailed information see chapter 3.1.

R Page views ranking — data for nodes with the highest number of page
views in a given target group are presented. For detailed information see

chapter 3.1.

?-5 Audience analysis — it enables to conduct any analysis according to the
criteria defined by the analyst; data for nodes that the analyst selects in media
tree or aggregates tree are presented. For detailed information see chapter
3.2.

3.1 Reach ranking and page views ranking

In order to analyze data for nodes with the highest number of visitors (real users), that

is with the highest reach, one has to click the icon 8l or choose option Reach ranking

in the View menu.

The data about nodes with the highest number of page views are available when

clicking on the icon 7] or choosing option Page views ranking in the View menu.

Rankings are available for any target group — one has only to define a given
target group (e.g. “women with higher education”) and then click the icon 28] (for

reach ranking) or icon 2] (for page views ranking).

In order to define ranking parameters one has to choose option gemiusExplorer options

in the Tools menu and then go to the tab Ranking default settings.
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lllustration 4 Ranking settings

It is possible to open the files in three modes:

- Reach ranking
- Page views ranking

- Audience analysis

The proper mode can be set with the use of option Open mode.

The ranking presents such a number of nodes that was defined in the option Number
of nodes to show. In order to change the default number one has to choose it from the

list or simply type it in.

It is also possible to define the type of nodes that are to be taken into account in the

ranking (option Consider):

- sites — internet web sites

- services — the nodes that are a part of web site

- categories — collecting nodes with web sites grouped into categories

- chats — applications that are internet chats (e.g. chat services on portals)

- messengers — internet messengers

- P2P applications — applications of a “peer to peer” type

- aggregates — collecting nodes that group many nodes, presented in aggregates

tree.
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In order to switch from ranking mode one has to select (or deselect) any site in the

tree or click the icon = (or choose option Audience analysis in the View menu).
Example:

We look for 15 web sites with the highest number of visitors in the target group

,women”.
- First of all we define the target group ,women” (see chapter: ,Defining a target
group”, page 18);

- We click the icon &l or choose option Reach ranking in the View menu.
- In the dialog window we set correct number of nodes that are going to be
presented (in this case: 15) and the type of nodes that should be considered (in

this case the option ,sites” should be selected).

In the result we receive 15 web sites visited by the highest number of women.

3.2 Audience analysis

In order to conduct one’s own audience analysis (e.g. comparison of results for several

web sites) the proper nodes should be selected in the tree.

The table panel with research results presents information about nodes selected in the
media tree or aggregates tree — marked as [¥. The easiest way to select one node is
clicking on the check box L on the left side of the name of the node. In such case

next to the name of the node this icon appears [,
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4 Metrics selection and data presentation

4.1 Metrics selection

It is possible to present in the table information about many different metrics (e.qg.

number of page views, reach, time share etc.) describing the audience of a particular

node.

The fastest way to select metrics for which data will be presented is the right click on

the head of the table.

Illustration 5

Wizitnr Panea Time
¥isitors {real users)

Page views

Avg. page views per yisitor {real user)
Time

Avqg. time spent per visitor {real user)
Avg. page view duration

Reach

Audience composition

Page view composition
Affinity index k
Audience share

Selection of metrics presented

The metric of interest can be chosen by clicking on its name. The metrics for which

data are presented are marked with .

Metrics can also be selected in menu Analysis, option Metrics.

The analysis of the following metrics can be conducted:

- Number of visitors (real users)

- Number of page views

- Avg. page views per visitor (real user)

- Time

- Avg. time spent per visitor (real user)

- Avg. page view duration

- Reach

- Audience composition

- Page view composition

-10 -
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- Affinity index

- Audience share

- Page view share

- Time share

- Visits

- Avg. visits per visitor (real user)

- Audience duplication %

- Population
- Type - information what the type (web site, service, chat, messenger, category,

aggregate) of a given node is.

Definitions of metrics are provided in chapter ,,Definition of terms” (page 30).

4.2 Data sorting

Data presented in the table can be sorted by selected metric in ascending or
descending order after clicking on the head of the column of this metric. Clicking on the

column’s head again causes change of sorting order.

Visitors (real 4 Page Time
users) views

2220925 3,420 016,206 257 4yrs202d

5,220,954 1,440 504565 2590wrs333d
5.060,086 1,238 870,428 1421yr=00d
5785042 838671530 1772ywrs146d

lllustration 6 Data sorting by selected metric

The exemplary data presented on illustration above were sorted in descending order

according to the number of page views.

In order to sort web sites alphabetically, one has to click on the column ,,Site”.

4.3 Metrics summary

In the right panel, apart from the list of nodes and the values of metrics for those

nodes, a summary is also presented — value of metrics for selected group of web sites.

-11 -
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Target Ho. Site Visitors (real A Page
group users) views
Sex=male 1  cad.pl 300,587 1,666,232
2 cdaction.pl 62,216 04,881
3 computersord.pl 61,262 189,407
4 cyber.com.pl 104,573 187,113
[ selected sites 500,325 2,737,633
lllustration 7 Summary of metrics for selected web sites

For example, summary presented on illustration 7 can be interpreted as following:

Visitors (real users) — total number of visitors (real users) for four selected web
sites amounts to 500 225. It is worth to remember that the visitor (real user) of
the particular site can also visit other sites (so called: audience duplication) —
thus the number of visitors (real users) for several web sites is smaller than (or

equal to) the sum of visitors (real users) for particular web sites.

Page views — number of page views generated on all four sites of the list.

Presentation of summary can be disabled — option Show nodes summary from the

View menu is meant for that reason.

4.4  Selection and deselection of groups of nodes

In order to analyze the audience of any node we are interested in, we have to click

check box LI on the left side of the node (in a media tree or in aggregates tree). The

icon [¥1 appears next to the name of the selected node.

Thanks to the option of group selection it is also possible to select in an easy way

whole groups of web sites.

-12 -
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lllustration 8 Group selection options

When highlighting a node in the media tree or aggregates tree with a left-click and

then performing a right-click (or choosing the option Site selection from menu Tree),

one gets access to the following commands:

Select highlighted and below - selects nodes situated at the lower level

("descendant” nodes);
Select nodes on same level — selects nodes situated at the same level;
Select all nodes — selects all nodes in the web sites’ tree;

Deselect highlighted and below — deselects nodes situated at the lower level

("descendant” nodes);
Deselect nodes on same level — deselects nodes situated at the same level;

Deselect all nodes — deselects all nodes in the web sites’ tree. This option can be

also activated by icon E:'

Inverse highlighted below — selects/deselects nodes situated at the lower level

("descendant” nodes);

Inverse selection on same level — selects/deselects nodes situated at the same

level;

Inverse all nodes — selects/deselects all nodes in the web sites’ tree;

-13 -
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- Select nodes with type... — selects all ,,descendant” nodes with a defined type and

belonging to a current collecting node.

4.5 Site searching

In order to search for a node in the tree based on part of its name, one has only to
activate the tree (click on a media tree or aggregates tree panel) and press buttons

Ctrl + F (or select option Find node from the Tree menu). In such case a window,

presented below, appears.

Find site x|

Search for: IbUSiﬂESS|

[~ Match caze v Search from beginming

k. & I Cancel

llustration 9 Searching for web sites based on names

Part of the node name can be entered in the Search for field.

If one selects the option Match case — then the case size in the name of web site is
taken into account. Selecting option Search from beginning causes searching through

the whole web sites’ tree.

14 -
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4.6 Table view

Several web sites for several target groups can be presented at the same time,

grouped according to the target group or according to the analyzed period.

Icons that enable to switch the view:
. & Periods on tabs, target groups first

Target Ho. Site Visitors (real Page views

'Y
group users)
Cex=fernale] 1 M=n.Com 1,084,751 12,344,214
2 yahoo.com 548,339 18,648,522
Selected sites 1,476 Q66 30,992 736
Ne——
ex=male ] 1 M=n.Com 1,280,571 15,906,023
2 yahoo.com G256 924 25,238 673
Selected sites 1,708 257 41,144 66

lllustration 10 Order by target groups
. O Periods on tabs, sites first

Ho. A Site Target Visitors (real Page views

group users)
1 M=n.Com MSex=tfemale] 1,084,751 12,344,214
Sex=male 1,280,571 15,906,023
Population 2,365,333 18,260,237
#  yahoo.com  [Sex=female] 50,330 18 fids 522
Sex=male 626,924 25,239,673
Population 176,263 43,837,105
lllustration 11 Order by web sites

The particular option of data presentation can be chosen in the View menu.

It is also possible to show URL masks of nodes — in order to do that one has to click

. Tl . .
icon == or in menu View choose option Nodes URL masks.

In order to disable the “URL masks” view one has to chose the adequate option in the
View menu or chose different style by clicking on icon & or icon m or by switching

to the reach ranking |E|, page view ranking %] or one’s own analysis ?-5

- 15 -
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4.7 Web sites names presentation

In the Tools menu there is a sub-menu gemiusExplorer options available that enables
to define the mode of nodes name presentation. It is possible not only to present the
name of a given node but also the name of a “parent” node. It can be defined in the

Parameters to show tab.

Options

Fanking default setings  Parameters to show l E=port ]

Show names of parent sites to the level of: |2 Levels j
Current level only

W zhow to the site leve 1 Level

3 Levels
4 Levels
5 Levels

llustration 12 Parameters of nodes names display

After selection of an adequate level it is possible to present the complete “path” of a

node.

A Site A Site

AGH Publiczre- Bdukacyjne - szkohy-AGH

krakoow. pl > Pozostate witmyny - Regionalne-krakow pl

wislakrakow com Pozostate witryny - Sport-wislakrakow com
llustration 13 Presentation of parent nodes names

The illustration above shows that the web site of AGH is situated in the tree within the
category ,,Publiczne (Public) -> Edukacyjne (Educational) -> Szkoty (Schools)”, whereas
the krakow.pl web site is situated within ,,Pozostate witryny (Other sites) -> Regionalne

(Regional)”.

4.8 Presentation of nodes below minimum rating

If the audience size of the node is small and collecting the sufficient sample for the
given target group was not possible — then the sign ,-“ (no data available) appears in

the statistics for this node.

- 16 -
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Visitors (real Page views Time
Users)
G 58T 6,228 593 10yrs234d

L : : N

75,044 1,085,377 lyrsiZad
708,501 7AI0,830  1Zyrs13id
lllustration 14 Web sites below minimum rating

In order not to present results for such web sites one has to deselect option Show sites

below minimum rating in the View menu.

4.9 Presentation of hodes with different colors

In case of analysis for population the nodes are presented in red and black color. In red
are marked those nodes that were included in the behavioral weighting, while in black

— those that were not weighted behaviorally.

When conducting analysis for target groups some of the nodes are presented in blue
color. It means that within this target group for this particular node the panel size was

not big enough. Statistics presented in blue should be treated just as an approximation.

Target group Ho. Site Visitors (real Page views Time

A users)
| Sex=fernala 1 e-bashket.pl 13772 a34,062 Tyrs131d
2 hkadma.pl 12,234 152,290 176d0Gh
3 nba.com 2,947 71,426 GOd0dh
Selected sites 37 626 a0a,378 2yrsl2d
Population 1 e-bashket.pl 53,807 2,191,107 Byrs263d
2 kadma.pl 40,326 G TG 36dd23h
3 nba.zom 21,1086 A63,255 Tyr=19d
Selected sites 111,814 3.2E2078 Syrsigid

llustration 15 Weighted / not weighted nodes

On the basis of the illustration above one can notice that the behavioral weighting was
conducted for nodes: e-basket.pl and kadra.pl (in the population analysis these nodes
are marked in red) — it means that there is a site-centric audit on these web sites.
Whereas the site nba.com is shown for the population in black, so it was not weighted
behaviorally. When analyzing the target group “women” we can also see that for web
sites kadra.pl and nba.com the number of panelists in this target group was too small

(so the nodes were marked in blue).

-17 -
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5 Target group definition

5.1

Defining a target group

Basic information about target groups

gemiusExplorer application enables defining target groups for which we want to
analyze selected metrics, e.g. target groups “women with higher education”, “persons

not older than 19”. Defining target groups can be done by choosing option Target

group definition from menu Target groups or by clicking on icon @ It is also
possible to load a definition of target groups from the file — the option Load target

group definition has to be chosen from the Target groups menu.

Defining new target groups

Tar{t groug clelinition E
¥
Fetnmale] el i[53 cr fgee[Z524]) |
[ retant e atla Agefassil
[ flaro adtaratzdl
1 3 El 1 5 L =
O T S —————————| - Logka thaiertes
] — P lamb's corprsion
: sl (A hl-Tua__] o e e
: ? |
& H Cles snije elsliibon
] —_— |
] i
7 f
T ‘f g Sangls 2450
3 i _LlJ Prygafalien T.EB4 75
T T T S P PP T ekl | b Fal | LR o
. ~ PrisFts el s ailatib Al ———————————
L Eur"“‘ 5 = Fullprareier srd yarisbinanes
male ‘r i+ Shalened preele sndveritHenees
=1 hgs rf Dy wailayle nare
[44] 4
AT
E;:;,t} Aednrmdiiion | Lnadimsiie |
[F:::EIH !lda-luumﬂiel'n'li:r[ Sava lofle |
[35] |
(a1 Educalizy il DrMle o e
(1l Hemberguairiomal Dliihe bar g ske vl oirhar] o |
=1 Haw cllpn uin niomet = -
1 Peazen's manihypret insots razloby al chxacleastize |
(4] Sk o pls ] rechdency
[l Mardigrcf prateadd i |he ook
@ Deeipalin =l Q&m'l
lllustration 16 Defining a target group

In order to define a new target group one has to click the icon @

Target group can be defined by dragging and dropping selected characteristic
available at the lower panel to the matrix. On the illustration above the target group

“men age 25-44” was defined — therefore the parameter ,male” (from the ,,gender”

-18 -
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group) was dragged to matrix and then, in the next line, the parameter describing the
age interval was placed: “25-34” and “35-44”. Name of such target group, assigned

automatically, is: (Gender=male) and (age=[25-34] or age=[35-44]).

It is possible to define a target group with the use of negation. For example — in order
to define target group “men, age other than 20-30” one can simply drag and drop to
the matrix characteristics “gender=male” and “age=[20-30]” and then double-click on
the cell containing age characteristic (it causes change in the condition for age to

“age<>[20-30]", what means exactly “age different than interval [20-30]").

1

1 Sem=male
2
lllustration 17 Negation of a condition in target group definition

Options available when defining target groups

When defining target groups the following options are available:

a) Name automatically — target groups are named automatically; this parameter can

be deselected if one wants to name the target group himself.

b) Logical character — enables to choose the logical character of the target group

definition.

[Sex=male or Age=[15-24]] and [Education=wyzsze or Person's monthly net=3001 PLM or more]

1 2 3
1 Sex=male Fge=[15-24]

2 Education=higher  { Perzon's monthly net income=3001 PLM or more |

3

lllustration 18 Matrix for creating target group definitions

Alternative’s conjunction — in each of the lines at least one of the conditions has to

be fulfilled (for whichever cell of the line).

For example in the illustration above the definition means exactly: (gender=male
or age=[15-24]) and (education=higher or person’s monthly net

income=3001PLN or more).

-19 -
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Conjunction’s alternatives — in whichever line where the conditions are entered, all
of the conditions have to be fulfilled. For the abovementioned example the
definition means exactly: (gender=male and age=[15-24]) or (education=higher

and person’s monthly net income=3001PLN or more).
Available buttons:

Adjust — sorts the matrix moving the selected cells to the left top corner of the

matrix;
Clear cell — deletes the content of currently selected cell of the matrix;

Clear entire definition — deletes target group definition (clears content of all cells

of the matrix).
c) Target group cardinality:

sample — sample size for the given target group;
population — internet users’ population size in the target group (concerns the

whole internet).

d) Parameter and variable names — enables the choice of presentation of parameter

and variable names in the matrix.

Buttons for adding and deleting target groups

In order to define a new target group one has to click Add new definition button — it
opens a new tab. With the use of Delete current definition button, a currently selected
target group definition can be deleted. The button Delete all definitions is used to
delete all previously entered definitions and only one target group remains:

"Population”.

The option Load from file enables to load a target group definition from a file. The next
option Save to file enables to save currently defined target groups to a file. (Operations
of saving/loading target group definitions can be also conducted form the Target

groups menu by choosing option Load target groups or Save target groups as....)

The button Divide by selected characteristic enables to quick define some types of
target groups. For example — in order to define target groups of women with different
levels of education one has to drag and drop the characteristic ,gender=female” to the
matrix field and then click on the characteristic ,education” and click Divide by selected

characteristic button. All required target groups were defined automatically.
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In order to define target groups based on the values of a given characteristic (e.g.
target groups by all age intervals) one has only to click on this characteristic (“age”)

and press the button Create by all characteristic.

Changes in target group definitions are confirmed by clicking on button Ok; if we resign
from confirming the changes in the target group definitions then we have to click on

the Cancel button.

Saving and loading target group definitions

In the window for defining target groups there are the following options available:

- Save to file — enables to save target group definition to a file. The same operation
can be done by choosing option Save target groups as... from the Target groups

menu.

- Load from file — in order to load target group definition from a file one just has to
click the button. The same operation can be done by choosing option Load target

groups from the Target groups menu.

Defining age intervals
gemiusExplorer 55 gives the possibility of defining any age interval for target groups.

For example — in order to define target group ,persons age 20-30” one has to:

open target group definition window @

right-click on the characteristic “age” and click field Define intervals

Define intervals
HI:IW [ong uze Internet

Hrua o iea mbannat

i-EH-F-FE-E

lllustration 19 Defining age interval - step 1

the window with default age intervals opens. In order to add new age interval
one has to click Insert. Enter number 20 in the first field and number 30 in the
other. Confirm changes by clicking OK. Button Delete removes the highlighted
line, while button Default enables to enter the default definitions of age

intervals.
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Age
20 a0 Insert
0 14 -
15 24 __Deete |
25 M
i) a4 Drefauilt
45 54
) i Wiece|
Ok, | Cancel
llustration 20 Defining age interval — step 2

among the defined age intervals the new interval ,,20-30” appeared. Now this

interval can be dragged and dropped as other intervals.

+- Sex
-l Age

[0-14] %

[15-24]
[25-34]
[35-44]
[45-54]
[55+]
+- Education
+- How lohg use internet

[N “

lllustration 21 Defining age interval - step 3

5.2 First nodes selection

gemiusExplorer enables searching the sites which audience is composed mostly from

the target group accordingly to the selected metric (e.g. number of page views).

In order to find sites with the highest values of the selected indicator in the given

target group, the following steps have to be taken:

- In media tree and/or aggregates tree select group of nodes among which the

nodes with optimum values will be chosen.
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- Select the metric according to which optimization will be conducted — display metric

in the right panel and sort data by that metric (click on the head of its column);

- Choose the option Select first n nodes according to the current order from the
Tools menu and define:
— number of web sites that we want to choose;
— research time period;

— target group for which the optimization is conducted.

Select first nodes x|
Selact |+ first nodes  for period: [10.2004 =
it lasged qrowp:
|(Ses=lemale] and [Age=[0-34]) |
Conce

llustration 22 Selection of optimization parameters

Optimization example:

Assume, that we want to provide certain information to the largest possible group of
particular internet users. Our target group is: women aged 35 and younger. We need
to find those sites that are visited by users that fulfill our criteria the best — i.e. web
sites that are visited mostly by women aged 35 and younger and their audience in

general is big enough. While conducting the analysis we can take the following steps:

- First of all, we define the target group of our interest (see chapter: ,Defining a

target group”, page 18);

- Then in the media tree we select all sites (after clicking on the collecting node we

choose option Select nodes with type... and select ,sites”);

- We choose metrics that we want to analyze, e.g. number of visitors (real users),

number of page views, audience composition etc.;

- We choose metric for which the optimization is conducted — we click on the head of

the selected metric, e.g. audience composition;

- Then from the Tools menu we choose option Select first n nodes according to the

current order. In the window that appears, we enter number 15 as a number of
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presented web sites, choose the preferred research time period and selected target

group (see illustration 22 above). We confirm the choice with the button Ok.

In this manner we have received a list of 15 web sites that users best match the
selected target group, i.e. women aged 35 or younger. Assume that we want to choose
only 5 web sites that generate the highest number of visits. In such case we need to
conduct another optimization based on previous results. Therefore we take the

following steps:

Choose the metric according to which next optimization is conducted — we click on

the head of ,Visits” column;

- Choose option Select first n nodes according to the current order from the Tools
menu. Limit the selection to only 5 web sites, choose the correct research time

period and click Ok.

Thanks to the next optimization we have received the list of five web sites with

audience composition matching our target group to the highest possible degree.

gemiusExplorer enables to conduct many optimizations, one after another, the next
optimization is based on the results of the previous one. In order to conduct the
optimization from the beginning (without taking the previous results into account) — all

that has to be done is deselection of all web sites and conducting the next optimization.
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6 Aggregates tree

The aggregates tree is an additional tree in which any nodes from the media tree can
be grouped. It is possible to use both trees at the same time, when analyzing the

research results — media tree and aggregates tree.

For example, in the aggregates tree we can place all web sites and services concerning
a certain topic — in such case it will not be needed to search for those sites in the base
media tree. The other example of an aggregates tree is a tree presenting web sites by

their owner or advertising network.

It is possible to define one’s own aggregates tree or load trees created before. In order
to load an aggregate tree one has to choose option Load aggregates tree from the
Tree menu or make a right click in the aggregates tree panel and choose option Load

aggregates tree.

6.1 Defining a new aggregates tree

Assume that we want to define aggregates tree grouping all web sites concerning

sport. We have to:

- make a right click in the aggregates tree panel and choose option Create new
aggregates tree. (If the aggregates tree panel cannot be seen it has to be opened
— in order to do that option Aggregates tree from the View menu has to be

chosen)
- enter the name of the tree, for example: sport services

- find web sites of our interest in the media tree. Click on name of the node that we

want to add to the tree and drag and drop the node to the aggregates tree
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Web sites |

..... O snowwboard,pl ;I
..... O speedway info.pl

..... O spartbizres.pl

..... O spatkcom.pl

..... O spotkoveefakby ol

----- O sports,pl

..... O spnrtsb:-;;d.pl

..... O squash.pl “

..... 1) stspl

..... O tenisportal .com =l
..... O wefa,com ®5p°rts'pl

..... O windsurﬁng.p}f >
J s | *

Aggregates frees

(=[] 4% sport sarwices
----- O e-nba.pl ‘-I"
- igal.pl ‘.r
-0 bundesgliga.pl
b sports,

lllustration 23 Defining an aggregates tree

6.2 Operations on aggregates tree

Different operations can be conducted on the aggregates tree after the right click in the

aggregates tree panel:

- Group nodes selection — option Nodes selection. This function is analogous to the
media tree — for detailed description see chapter 4.4 ,Selection and deselection of

groups of nodes” (page 12).

- Searching the node based on the name — option Find node.... This function is
analogous to the media tree — for detailed description see chapter 4.5 “Site

searching” (page 14).
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spotk services

H

O Nodes selection 3
O @ igal.pl

O [l bundesliga.pl Find node... Ctrl+F

O @ sports.pl
[]4°% Mew aggregates tres Create new aggregates tree

Load aggregates tree...
Save aggregates tree
Save aggregates tree as...
Close aggregates tree

Add node
Delete node

lllustration 24 Operations on aggregates tree

Creating next aggregates tree— option Create new aggregates tree.

Opening already existing aggregates tree — option Load aggregates tree....

Saving aggregates tree to a file — option Save aggregates tree or Save aggregates

tree as....

Closing currently opened aggregates tree — option Close aggregates tree.

Adding a new node (catalogue) in a tree — option Add node.

Deleting a node — option Delete node.

Change of name of the aggregates tree — option Change node name.

- 27 -



gemiusExplorer — Data saving and exporting

7 Data saving and exporting

7.1 Data export

Data presented in tables in right panel can be exported:
a) to csv file — option Export analysis results to file in the Analysis menu;

b) to Excel file — option Open analysis results as CSV in the Analysis menu.
Such data can be easily analyzed with the use of other tools.

Data are exported in a form of values separated with commas. In order to change field
separator into some other sign one has to use menu Tools, sub-menu gemiusExplorer
options, tab Export. It is also possible to change the decimal tab there (used to

separate in a number the total part from the fraction part).

Dptions

Ranking default seltings] Parameters bo show  Expoit I

+ ITabl ™ Corma i Semicolon

Decimal tab: r

Ok, & | Cancel Apply Help

lllustration 25 Export settings

7.2 Saving an analysis

It is possible to save an analysis, that is information about: currently selected nodes,
aggregates tree opened, defined target groups and metrics presented. It helps to
retrieve the analysis state on the next day and defining all the parameters will not have

to be done (i.e. selection of metrics, target groups etc.)

-28-



gemiusExplorer — Data saving and exporting

In order to save the analysis one has to choose option Save analysis as.... from the
Analysis menu. The option Open analysis... (from the Analysis menu) enables to

bring back previously defined analysis.
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8 Definition of terms

This chapter contains definitions of key terms directly related to measuring web sites’
audience, including the definitions of metrics generated thanks to gemiusExplorer

application.

Page view — loading of a WWW document of a given internet web site. This event is
assigned to the identifier used for the special tracking script made available by
Gemius SA.

Time - sum of times spent by visitors (real users) in the given target group on the

selected web site(s). Indicator is given in years, days and hours.

Visit - series of page views on a given web site (node), uninterrupted by a period

longer than 30 minutes.

Number of visitors (real users) — number of internet users in the given target
group who generated at least one page view on the selected web site in the given
month. This indicator relates to the actual number of persons (not computers, cookies

or IP addresses) who visited the web site in the given month.

Number of page views — number of page views generated by the given target group

on selected web site(s) in the given time period.

Avg. time spent per visitor (real user) — total time spent by average visitor (real

user) in the given target group on the selected web site(s).

Avg. page view duration — average time between two page views of the same visit,

generated by the given target group on selected web site(s) in the given time period.

Avg. page views per visitor (real user) — number of page views on selected web
site(s) generated by an average visitor (real user) in the given target group in the given

time period.

Avg. visits per visitor (real user) — number of visits generated by an average visitor

(real user) in the given target group in the given time period.

Reach — expressed as a percentage, the ratio of the number of visitors (real users)
who generated at least one page view on selected web site in the given time period to

the total number of internet users in the given time period.
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Audience composition - expressed as a percentage, the ratio of visitors (real users)
in a given target group who visited selected web site, to the total number of visitors

(real users) on selected web site in the given time period.

Page view composition - expressed as a percentage, the ratio of page views
generated by a given target group on selected web site to the number of page views

generated by all visitors (real users) on selected web site in the given time period.

Affinity index - ratio of audience composition in the given target group on selected

web site to the audience composition in the given target group for the entire internet.

Audience share — expressed as a percentage, the ratio of visitors (real users) in the
target group on selected web site to visitors (real users) in the target group of all

examined web sites in the given time period.

Page view share — expressed as percentage, the ratio of page views generated on
the selected web site by visitors (real users) in the given target group to the page
views generated by visitors (real users) in the target group on all examined web sites in

the given time period.

Time share — expressed as a percentage, the ratio of total time spent on selected web
site by members of the target group, to the total time spent on all examined web sites

by members of the target group.

Audience duplication % —percentage of visitors (real users) of a given web site who

are also visitors (real users) of at least one of other selected web sites (nodes).

Population — complete number of visitors (real users) in the given time period.
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9 Contact

Detailed information about using the gemiusExplorer application are available in Help

menu, option User guide.

Additional information about gemiusExplorer application can be received by sending an

e-mail to the e-mail address kontakt@gemius.pl.

Contact:
Gemius SA
Potczynska st. no 31A
01-377 Warsaw, Poland
tel.: (+4822) 5339610
Www.gemius.com

e-mail: kontakt@gemius.pl
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